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BAB III 

METODE PENELITIAN 

 

A. Jenis dan Pendekatan Penelitian 

Jenis penelitian ini merupakan jenis penelitian lapangan, peneliti terlibat 

langsung di lapangan untuk mengumpulkan informasi. Dalam penelitian ini, 

yang menjadi fokus utamanya adalah untuk mengkaji apakah terdapat pengaruh 

dalam penerapan model problem based learning (PBL) terhadap kemampuan 

berpikir kreatif siswa pada mata pelajaran IPAS di kelas V SDIT Al-Hikmah 

Banjarmasin. Pendekatan pada penelitian ini yaitu dengan menggunakan 

pendekatan kuantitatif. Pendekatan ini digunakan untuk meneliti populasi atau 

sampel tertentu, biasanya melalui pengumpulan data menggunakan instrumen 

penelitian. Kuantitatif bergantung pada pengumpulan dan analisis data numerik 

untuk mendeskripsikan, menjelaskan, mengendalikan variabel, dan fenomena 

yang menarik31. Data yang diperoleh dianalisis secara kuantitatif atau statistik 

guna menguji hipotesis yang telah dirumuskan sebelumnya. Penelitian 

kuantitatif menekankan pada analisis data berbentuk angka (numerik) yang 

diperoleh melalui teknik statistik. Adapun data yang dikumpulkan dalam 

penelitian ini meliputi hasil tes awal siswa (pretest) dan hasil tes akhir (posttest). 

B. Desain Penelitian 

Desain penelitian yang diterapkan pada penelitian ini adalah pre-

eksperiment one group pretest posttest yaitu penelitian yang dilakukan dengan 

percobaan untuk mengetahui pengaruh variable independent (perlakuan) 

terhadap variable dependen (hasil) dalam kondisi yang dikendalikan dan akan 

dianalisis secara statistik dengan cara pengukuran sebelum dan sesudah32. 

 
31 Craig A. Mertler, Introduction to Educational Research (SAGE Publications, 2024). 
32 M. Farhan Arib et al., “Experimental Research dalam Penelitian Pendidikan,” 

Innovative: Journal Of Social Science Research 4, no. 1 (2024): 5497–511, 

https://doi.org/10.31004/innovative.v4i1.8468. 



34 

 

Sampel penelitian sebelumnya akan diberikan pretest. Setelah 

melakukan pretest, akan diberikan intervensi berupa pembelajaran IPAS 

tentang kegiatan ekonomi dengan menggunakan model problem based 

learning (PBL). Kemudian setelah intervensi dilaksanakan maka dilakukan 

posttest untuk mengetahui apakah ada pengaruh penggunaan model problem 

based learning (PBL) terhadap kemampuan berpikir kreatif. 

Untuk memberikan gambaran yang lebih jelas, desain penelitian ini 

dapat digambarkan dalam bentuk skema berikut: 

Tabel 3. 1 Desain one group pretest posttest 

O₁ X O₂ 

Keterangan :  

O₁  : Pretest 

O₂  : Posttest 

X  : Treatment 

Keterangan: 

1. Tahap Pertama: Pelaksanaan Pretest 

Pada tahap awal, siswa diberikan pretest berupa soal-soal untuk mengukur 

kemampuan awal siswa sebelum diberikan perlakuan pembelajaran. 

2. Tahap Kedua: Pemberian Perlakuan (Treatment) 

Pada tahap ini, siswa menerima perlakuan berupa pelaksanaan 

pembelajaran dengan menerapkan model problem based learning (PBL). 

3. Tahap Ketiga: Pelaksanaan Posttest 

Pada tahap akhir, siswa kembali diberikan tes yang sama dengan pretest. 

Hasil dari posttest ini digunakan untuk menilai pengaruh perlakuan yang 

telah diberikan kepada hasil belajar yang telah didapatkan oleh siswa. 
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C. Setting Penelitian 

Pelaksanaan penelitian ini dilakukan di SDIT Al-Hikmah Banjarmasin 

pada kelas V di semester genap tahun ajaran 2025/2026. Beralamatkan Jl. 

Kelayan A No. II, RT. 15/RW. 02, Murung Raya, Kec. Banjarmasin Selatan 

Kota Banjarmasin, Kalimantan Selatan 70247. 

Sekolah ini dipilih sebagai lokasi penelitian karena memiliki jumlah 

siswa yang memadai serta sesuai dengan pemilihan model pembelajaran yaitu 

problem based learning karena sekolah ini lagi menerapkan model tersebut 

untuk pelaksanaan di kelas, berdasarkan wawancara dengan guru kelas bahwa 

model PBL ini belum sering digunakan di kelas dan guru masih banyak 

menggunakan model konvensional seperti ceramah, apalagi pada mata 

pelajaran IPAS penggunaan model PBL jarang digunakan. Berdasarkan 

wawancara dengan siswa dan guru, penggunaan model ini pernah digunakan 

pada mata pelajaran Bahasa Indonesia dan Matematika.  

 

D. Populasi dan Sampel Penelitian 

1. Populasi 

Populasi adalah keseluruhan elemen yang akan dijadikan wilayah 

generalisasi. Elemen populasi adalah keseluruhan subjek yang diukur, 

yang merupakan unit yang diteliti33. Populasi yang ditetapkan dalam 

penelitian ini adalah siswa kelas V Al-Hakim SDIT Al-Hikmah 

Banjarmasin semester genap tahun 2025/2026.  

Pemilihan siswa kelas V sebagai populasi didasarkan pada 

pertimbangan bahwa siswa pada jenjang tersebut telah memiliki 

kemampuan berpikir yang lebih berkembang dibandingkan kelas rendah, 

sehingga dinilai mampu mengikuti pembelajaran berbasis pemecahan 

masalah dan mengemukakan ide-ide kreatif dalam proses pembelajaran 

IPAS. Selain itu, berdasarkan hasil observasi awal, keterampilan berpikir 

 
33 Dearlina Sinaga and Sethepy Indah Putri Sinaga, Pengaruh Kemampuan Guru Dalam 

Penggunaan Media  Pembelajaran Daring Terhadap Hasil Belajar Siswa, 2 No.3 (2021), 

https://doi.org/10.47492/jip.v2i3.772. 
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kreatif siswa kelas V masih perlu ditingkatkan sehingga sesuai dengan 

tujuan penelitian yang berfokus pada peningkatan kemampuan berpikir 

kreatif melalui penerapan model Problem Based Learning (PBL). 

Tabel 3. 2 Data Jumlah Populasi Siswa Kelas V SDIT Al-Hikmah 

Banjarmasin Tahun Ajaran 2025/2026. 

Kelas  Perempuan Laki-Laki Jumlah Siswa 

V Al-Hakim 11 8 19 

 

2. Sampel 

Sampel adalah bagian dari jumlah dan karakteristik yang dimiliki 

oleh populasi34. Sampel dalam penelitian ini adalah seluruh siswa kelas V 

Al-Hakim SDIT Al-Hikmah Banjarmasin yang berjumlah 19 siswa. 

Pemilihan kelas V Al-Hakim sebagai sampel dilakukan dengan teknik 

sampling jenuh (total sampling), yaitu teknik penentuan sampel apabila 

seluruh anggota populasi digunakan sebagai sampel penelitian. Pemilihan 

kelas tersebut didasarkan pada beberapa pertimbangan, yaitu: 

a. Kelas V Al-Hakim merupakan satu-satunya kelas yang menjadi 

populasi penelitian 

b. Berdasarkan hasil observasi awal ditemukan bahwa kemampuan 

berpikir kreatif siswa masih belum berkembang secara optimal dalam 

pembelajaran IPAS 

c. Guru kelas memberikan dukungan terhadap pelaksanaan penelitian 

sehingga memungkinkan penerapan model problem based learning 

(PBL) secara optimal selama proses pembelajaran berlangsung. 

 

 

 
34 Nidia suriani et al., “konsep populasi dan sampling serta pemilihan partisipan ditinjau 

dari penelitian ilmiah pendidikan,” jurnal ihsan : jurnal pendidikan islam 1, no. 2 (2023): 24–

36, https://doi.org/10.61104/ihsan.v1i2.55. 
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E. Data dan sumber data 

1. Data Primer 

Data primer adalah informasi utama yang akan diolah dan 

dianalisis, yang diperoleh langsung melalui pengamatan dan wawancara. 

Data Primer penelitian ini mencakup: 

a. Kemampuan berpikir kreatif sebelum diterapkan model problem 

based learning (PBL) pada mata pelajaran IPAS di Kelas V. 

b. Kemampuan berpikir kreatif setelah diterapkan model problem based 

learning (PBL) pada mata pelajaran IPAS di Kelas V. 

c. Pengaruh model problem based learning (PBL) terhadap kemampuan 

berpikir kreatif siswa pada mata pelajaran IPAS.      

2. Data Sekunder 

Data penunjang yaitu seperti latar belakang, lokasi, sejarah 

berdirinya SDIT Al-Hikmah, keadaan guru, siswa, sarana dan prasarana 

sekolah, serta jadwal belajar yang ada di sekolah pada tahun pelajaran 

2025/2026.   

3. Sumber Data 

Adapun data primer dan data sekunder dalam penelitian ini 

diperoleh dari berbagai sumber data, yaitu: 

a. Kepala sekolah SDIT Al-Hikmah Banjarmasin. 

b. Guru wali kelas V Al-Hakim di SDIT Al-Hikmah Banjarmasin. 

c. Siswa kelas V Al-Hakim di SDIT Al-Hikmah Banjarmasin. 
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F. Teknik Pengumpulan data 

Informasi dan data yang diperlukan pada penelitian ini didapatkan 

melalui observasi, tes, dokumentasi dan wawancara: 

1. Observasi 

Teknik ini dilakukan dengan mengamati secara langsung objek 

penelitian untuk melihat aktivitas yang berlangsung di lapangan. Observasi 

dilakukan agar peneliti mampu mendapatkan data deskriptif mengenai 

lokasi penelitian, kondisi siswa, proses pembelajaran, jumlah guru dan 

staf, juga sarana dan prasarana yang ada. Observasi ini juga berguna 

sebagai data pelengkap yang menggambarkan pelaksanaan model problem 

based learning (PBL) pada mata pelajaran IPAS di kelas V. 

2. Tes 

Penelitian ini menggunakan tes berpikir kreatif sebagai instrumen 

utama untuk mengukur kemampuan siswa dalam memecahkan masalah 

melalui model problem based learning (PBL). Instrumen ini 

dikembangkan oleh peneliti dan telah melalui tahap validasi oleh validator 

yang memiliki keahlian di bidang IPAS guna memastikan bahwa butir-

butir soal telah layak dan valid sebelum diuji cobakan. Dalam 

penerapannya di kelas, penilaian dilakukan dalam dua bentuk: tes individu 

(melalui pretest dan posttest) dan tes berkelompok (melalui LKPD). 

Rangkaian tes ini bertujuan untuk mengevaluasi sejauh mana proses 

pemecahan masalah di kelas dapat meningkatkan kreativitas dan 

pemahaman siswa pada materi IPAS. 

3. Dokumentasi 

Dokumentasi merupakan pemerolehan data yang didapatkan baik 

secara langsung maupun melalui arsip-arsip yang ada35. Dokumentasi 

dalam penelitian ini terdiri dari daftar nama dan jumlah siswa, deskripsi 

singkat tentang profil dan lokasi sekolah, sejarah berdirinya sekolah, visi 

 
35 Gagah Daruhadi dan Pia Sopiati, Pengumpulan Data Penelitian, 2024.3. 
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dan misi, foto kegiatan selama proses pembelajaran, serta informasi lain 

yang berkaitan dengan penelitian. 

4. Wawancara 

Untuk mendapatkan informasi yang lebih mendalam, 

peneliti/pewawancara melakukan wawancara mendalam. Wawancara 

mendalam adalah suatu cara mengumpulkan data atau informasi dengan 

cara langsung bertatap muka dengan informan agar mendapatkan data 

lengkap dan mendalam. 

Jadi dari penjelasan di atas dapat disimpulkan bahwa wawancara 

merupakan metode yang digunakan untuk memperoleh informasi secara 

langsung, mendalam, tidak terstruktur dan individual. Untuk mendapatkan 

informasi peneliti melakukan wawancara dengan kepala sekolah, guru 

wali kelas Va dan siswa di SDIT Al-Hikmah Banjarmasin. 

 

G. Instrumen Penelitian 

Pada penelitian ini, instrumen yang digunakan meliputi tes berupa 

pretest dan posttest. Nilai dari setiap variabel yang diteliti diukur melalui 

instrumen pengumpulan data yang telah disusun secara sistematis. Sebelum 

digunakan, instrumen tes terlebih dahulu harus memenuhi kriteria valid dan 

reliabel agar benar-benar mampu mengukur apa yang seharusnya diukur serta 

menghasilkan data yang konsisten.  

Instrumen tes disusun berdasarkan capaian pembelajaran dan tujuan 

pembelajaran pada mata pelajaran Ilmu Pengetahuan Alam dan Sosial (IPAS) 

dengan materi Kegiatan Ekonomi untuk kelas V. Bentuk tes yang digunakan 

adalah tes tertulis berupa uraian. Jumlah soal yang divalidasi sebanyak 8 butir, 

yang selanjutnya diklasifikasikan ke dalam indikator-indikator pembelajaran 

sesuai dengan kompetensi yang ingin dicapai. 
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Tabel 3. 3 Kisi-Kisi Soal Pembelajaran IPAS 

Capaian 

Pembelajaran 
Materi 

Indikator 

berpikir kreatif 
Indikator soal 

Bentuk 

soal 

Butir 

soal 

Siswa mampu 

memahami sistem 

alur kegiatan 

ekonomi dan peran 

masing-masing 

pelaku 

ekonomi(produsen, 

distributor, dan 

konsumen) dalam 

memenuhi 

kebutuhan hidup. 

Siswa mampu 

mengidentifikasi 

permasalahan 

ekonomi di 

lingkungan 

sekitarnya, serta 

menggunakan 

kemampuan 

berpikir kreatif 

untuk 

menyarankan 

Solusi alternatif 

dalam mengatasi 

permasalahan 

ekonomi. 

Kegiatan 

Ekonomi 

Berpikir Lancar 

(Fluency) 

 

Kemampuan 

menghasilkan 

banyak ide, 

jawaban, atau 

penyelesaian 

masalah secara 

lancer. 

Mampu 

menyebutkan 

daftar benda 

hasil produksi di 

kelas secara 

kuantitatif 

(jumlah 

banyak). 

Essay 1 

Siswa sapat 

menyebutkan 

mengidentifikasi 

berbagai jenis 

produk olahan 

makanan dari 

bahan baku 

pisang dalam 

peran sebagai 

produsen 

Essay 2 

Berpikir Luwes 

(Flexibility) 

 

Kemampuan 

menghasilkan 

ide yang 

beragam atau 

berpindah dari 

satu sudut 

pandang ke 

sudut pandang 

lain. 

siswa dapat 

mengidentifikasi 

berbagai 

masalah yang 

akan muncul 

akibat hilangnya 

peran distributor 

dan konsumen 

dalam kegiatan 

ekonomi 

Essay 3 

Mampu 

memberikan 3 

solusi yang 

bervariatif 

Essay 4 

Berpikir Orisinil 

(Originality) 

 

Siswa mampu 

menciptakan 

sebuah ide 

produk daur 

ulang yang 

memiliki nilai 

Essay 5 
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Kemampuan 

melahirkan ide-

ide unik, baru, 

atau ide yang 

jarang 

terpikirkan oleh 

orang lain. 

estetika atau 

fungsi baru yang 

tidak biasa. 

Siswa mampu 

merancang 

konsep 

pengeolaan 

wisata yang 

autentik dan 

memiliki daya 

Tarik khas 

(branding unik) 

Essay 6 

Berpikir Merinci 

(Elaboration) 

 

Kemampuan 

memperinci, 

memperluas, dan 

mengembangkan 

alur pemikiran 

secara detail. 

Mampu  

menjelaskan 

perjalanan 

barang mulai 

dari produsen, 

distributor, 

hingga ke 

tangan 

konsumen 

Essay 7,8 

 

Lembar observasi keterlaksanaan digunakan sebagai instrumen 

pendukung yang berfungsi mencatat sejauh mana implementasi model 

pembelajaran sesuai perencanaan. Observasi ini memastikan setiap tahapan 

pembelajaran berlangsung secara sistematis dan mengikuti prosedur yang telah 

ditetapkan. Modul ajar kurikulum merdeka dirancang secara komprehensif 

dengan mencakup CP, TP,  rangkaian kegiatan pembelajaran, dan LKPD 

sebagai bahan ajar siswa. Keberadaan modul ajar mendukung efektivitas 

pembelajaran sekaligus memberikan pengalaman belajar yang lebih terstruktur 

sesuai dengan konsep kurikulum merdeka. Keabsahan instrumen penelitian 

dijamin melalui validasi oleh dosen ahli serta guru IPAS. Instrumen yang telah 

divalidasi kemudian diuji coba kepada siswa yang telah mempelajari materi 

relevan. Uji coba tersebut memastikan bahwa instrumen penelitian memiliki 
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validitas dan reliabilitas yang memadai sehingga layak digunakan untuk 

mengukur kemampuan berpikir kreatif di kelas eksperimen. 

H. Teknik Analisis Data 

Analisis data adalah pengolahan data yang diperoleh dengan 

menggunakan rumus-rumus atau aturan yang ada sesuai dengan pendekatan 

penelitian atau desain yang diambil. Proses pengolahan data dilakukan dengan 

memanfaatkan perangkat lunak IBM SPSS Statistics 25 untuk memastikan 

ketelitian dan keakuratan hasil. Teknik analisis data dalam penelitian ini yaitu 

analisis statistik deskriptif untuk menganalisis data dengan cara 

mendeskripsikan nilai siswa dan analisis statistik menggunakan Uji 

Normalitas, dan pengujian Hipotesis. 

1. Uji Statistik Deskriptif 

Statistik deskriptif pada hakikatnya adalah proses merangkum dan 

menyajikan data penelitian ke dalam bentuk yang lebih sederhana sehingga 

mudah dipahami serta dianalisis. Melalui tabulasi, data dapat diringkas, 

diatur, dan ditampilkan baik dalam bentuk angka maupun grafik. 

Umumnya, teknik ini dimanfaatkan peneliti untuk menggambarkan 

karakteristik variabel yang diteliti sekaligus mendukung interpretasi hasil 

penelitian. Aktivitas dalam statistik deskriptif meliputi perhitungan nilai 

rata-rata (mean), nilai minimum, nilai maksimum, dan standar deviasi 

2. Analisis Statistik Inferensial 

Analisis statistika inferensial digunakan untuk menguji hipotesis 

penelitian dengan menggunakan uji-t. Namun sebelum dilakukan 

pengujian hipotesis, terlebih dahulu dilakukan uji normalitas36. 

 

 

 
36 Nur Rahmatan Mursalin, Pengaruh Strategi Pembelajaran Critical Incident Terhadap 

Hasil Belajar Bahasa Indonesia, 13, no. 2 (2023), 

https://doi.org/https://doi.org/10.36915/jitu.v13i2.253. 
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a. Uji normalitas 

Uji normalitas dilakukan untuk mengetahui apakah data pretest 

berdistribusi normal atau tidak. Metode yang digunakan adalah 

Shapiro-Wilk. Data dinyatakan berdistribusi normal apabila nilai 

signifikansi (sig.) lebih besar atau sama dengan 0,05, sedangkan nilai 

signifikansi kurang dari 0,05 menunjukkan data tidak normal. 

Langkah-langkah dalam melakukan uji normalitas dengan SPSS 

Statistics 25 adalah sebagai berikut:  

Masukkan data ke Data View, kemudian pilih Analyze → Descriptive 

Statistics→ Explore. Selanjutnya, masukkan data Pretest dan Posttest 

ke dalam Dependent List, klik Plots, lalu centang Histogram pada 

bagian Descriptive, lalu centang Normality plots wits tests, klik 

Continue, dan akhiri dengan OK.  

b. Uji Hipotesis (Uji Pengaruh Perlakuan) 

Tahap analisis data terakhir adalah pengujian hipotesis dengan 

menggunakan T-test (pretest posttest). Uji ini diperlukan untuk 

menguji signifikan kondisi penelitian sebelum dan sesudah perlakuan. 

Adapun langkah-langkah uji hipotesis dengan Paired Samples T-Test 

pada SPSS yaitu,  

Input data melalui Variable View → Data View, pilih Analyze → 

Compare Means → Paired Samples T-Test, masukkan data pretest ke 

dalam Variable 1 dan data posttest ke dalam variable 2, klik Options 

→ Continue → OK.  

Dasar pengambilan keputusan yaitu jika nilai sig. (2-tailed) < 

0,05, maka Ho ditolak dan Ha diterima, artinya terdapat pengaruh yang 

signifikan dari penerapan model problem based learning (PBL) 

terhadap kemampuan berpikir kreatif siswa pada mata pelajaran IPAS 

kelas V SDIT Al-Hikmah Banjarmasin. Jika nilai sig. (2-tailed) ≥ 0,05, 

maka H₀ diterima dan Ha ditolak, artinya tidak terdapat pengaruh yang 

signifikan dari penerapan model problem based learning (PBL) 



44 

 

terhadap kemampuan berpikir kreatif siswa pada mata pelajaran IPAS 

kelas V SDIT Al-Hikmah Banjarmasin.  

 

I. Teknik Validasi dan Keabsahan Data 

Teknik validitas dan keabsahan data dilakukan sebelum penelitian 

untuk mengolah data. Uji validitas dan reliabilitas digunakan untuk 

memastikan instrumen penelitian valid dan reliabel. 

1. Uji Validitas 

Penelitian ini menerapkan uji validitas sebagai bagian dari analisis 

instrumen. Istilah validitas berasal dari kata validity, yang mengandung 

makna ketepatan serta kebenaran suatu instrumen dalam mengukur apa 

yang seharusnya diukur, validitas menunjukkan tingkat kemampuan suatu 

instrumen mampu menjalankan fungsi pengukurannya dengan tepat. 

Validitas merupakan indeks yang menegaskan bahwa suatu alat ukur 

dapat digunakan secara akurat untuk mengukur objek yang semestinya 

diukur. Pada penelitian ini, uji validitas dilakukan melalui proses validasi 

oleh validator serta pengujian terhadap butir soal. 

a. Uji Validitas kepada Tim Validator 

Sebelum instrumen penelitian diberikan kepada siswa, terlebih 

dahulu dilakukan proses validasi untuk memastikan kualitas dan 

kelayakan instrumen yang digunakan. Pada penelitian ini, proses 

validasi dilakukan oleh dua validator yang terdiri atas satu dosen, yaitu 

Ibu Huriyah, S.Pd., M.Pd yang merupakan dosen pada Program Studi 

Pendidikan Guru Madrasah Ibtidaiyah, Fakultas Tarbiyah dan 

Keguruan, UIN Antasari Banjarmasin. Selain itu, seorang pendidik 

dari SDIT Al-Hikmah Banjarmasin, yaitu Ibu Heny Oktaviani, S.Pd., 

juga dilibatkan sebagai validator.  
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b. Uji Validitas Soal 

Pelaksanaan uji validitas dimaksudkan untuk mengetahui 

sejauh mana butir soal mampu merepresentasikan konstruk yang 

hendak diukur dalam penelitian ini. Suatu instrumen dinyatakan valid 

apabila nilai r-hitung yang diperoleh lebih besar daripada r-tabel, 

sedangkan apabila nilai r-hitung lebih kecil dari r-tabel, maka butir 

soal dinyatakan tidak valid. Proses analisis validitas dilakukan dengan 

bantuan IBM SPSS Statistics 25 for Windows melalui tahapan:  

Data → Analyze → Correlate → Bivariate → memasukkan semua 

butir soal dan totalnnya kedalam Variables → centang Pearson, Two-

tailed dan Flag significant correlations→ OK. 

Nilai korelasi (r-hitung) selanjutnya dibandingkan dengan nilai 

r tabel pada taraf signifikansi 5%. Jika diperoleh r-hitung < r-tabel, 

maka butir soal tidak signifikan sehingga dinyatakan tidak valid. 

Sebaliknya, apabila r hitung > r-tabel, maka korelasi signifikan dan 

instrumen soal tersebut dapat dinyatakan valid. Uji coba instrumen 

dilaksanakan secara langsung di ruang kelas. Responden yang dipilih 

adalah siswa yang telah memperoleh materi Kegiatan Ekonomi 

sebelumnya. 

Tabel 3. 4 Kesimpulan Hasil Validitas Uji Coba 

Nomor Soal 

r-hitung 

(Pearson 

Correlation) 

r-tabel Kesimpulan 

1 0,456 

0,456 

Valid 

2 0,497 Valid 

3 0,644 Valid 

4 0,502 Valid 

5 0,268 Tidak Valid 

6 0,640 Valid 

7 0,644 Valid 

8 0,800 Valid 
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Berdasarkan hasil perhitungan uji validitas menggunakan 

korelasi Pearson Product Moment melalui IBM SPSS Statistics 25 for 

Windows, diperoleh nilai korelasi antara setiap butir soal dengan skor 

total. Dengan jumlah responden sebanyak 19 orang, maka diperoleh r-

tabel pada taraf signifikansi 5% 0,456. Hasil analisis menunjukkan 

bahwa dari 8 butir soal yang diuji, terdapat 7 soal yang memiliki nilai 

r-hitung > 0,456 atau = 0,456 sehingga dinyatakan valid (nomor 1, 2, 

3, 4, 6, 7, dan 8). Sementara itu, terdapat 1 soal yang memiliki nilai r 

hitung < 0,468 sehingga dinyatakan tidak valid (nomor 5).  

2. Uji Reliabilitas 

Reliabilitas adalah sejauh mana alat ukur dapat dipercaya untuk 

pengumpulan suatu data. Uji realibilitas dilakukan dengan cara 

menggunakan pertanyaan yang sebelumnya sudah melalu tahap validasi, 

selanjutnya akan ditentukan tingkat reliabilitasnya dengan menggunakan 

program SPSS statistics 25.  

Adapun langkah-langkah perhitungan uji reliabilitas sebagai 

berikut. 

a. Buka SPSS statistics 25. 

b. Klik menu Analyze – Scale – Reliability Analysis 

c. Selanjutnya, pindahkan butir soal yang sudah valid ke dalam kotak 

item. Pada model, klik opsi Alpha. 

d. Kemudian klik statistic, pada bagian descriptives for centang item. 

Lalu klik continue, kemudian OK.  

e. Kemudian akan muncul output SPSS perhitungan uji reliabilitas butir 

tes.  

Hasil perhitungan dapat dilihat pada tabel Reliability Statistics. 

Pada bagian Cronbach’s Alpha dapat dilihat nilai berkisar antara 0 hingga 

1. Umumnya, realibilitas nilai di atas 0,7 dianggap baik atau memenuhi, 

sedangkan nilai di atas 0,8 dianggap sangat baik. 
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Berdasarkan hasil perhitungan uji validitas dan reliabilitas yang telah 

dilakukan, item yang dinyatakan valid dan reliabel dapat digunakan 

sebagai instrumen untuk mengumpulkan data dalam penelitian ini. 

Tabel 3. 5 Hasil Perhitungan Uji Validitas dan Reliabilitas 

No 

Pernyataan 

Validitas Reabilitas 

r-

hitung  

r-

tabel 
Keterangan 

Cronbach 

Alpha 

Keterangan 

1 0,456 

0,456 

Valid 

0,726 Tinggi 

2 0,497 Valid 

3 0,644 Valid 

4 0,502 Valid 

5 0,268 Tidak Valid 

6 0,640 Valid 

7 0,644 Valid 

8 0,800 Valid 

 

Berdasarkan tabel di atas, dapat disimpulkan bahwa dari 8 butir soal yang 

diuji, sebanyak 7 soal dinyatakan memenuhi kriteria validitas, yaitu 

nomor 1, 2, 3, 4, 6, 7, dan 8. Oleh karena itu, peneliti memilih 7 soal untuk 

digunakan sebagai instrumen pretest dan posttest. Pemilihan 7 soal 

dilakukan dengan mempertimbangkan nilai validitas tertinggi serta 

kesesuaian dengan indikator kemampuan berpikir kreatif yang akan 

diukur. 

 

 

 

 

 

 


